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1 ~ Introduction to System Galaxy Interface to the Vista Panel 
IMPORTANT 

 Vista Panel cannot transmit events/alarms to System Galaxy when the alarm panel is  in programming mode 
 Vista Panel cannot transmit events/alarms to System Galaxy when the panel is  offline (not connected) 
 Galaxy Alarm Panel service must be running to receive events. Vista Panel does not buffer events. 

Overview of Features 

System Galaxy (SG) integrates with the Ademco Vista Alarm Panel to provide the following: 
 ability to communication to multiple alarm panels using TCP/IP to Lantronix serial connection
 ability to communicate to a single panel using RS-232 direct connect
 ability to detect alarms in System Galaxy from Vista Panels
 ability to arm and disarm the alarm system from System Galaxy
 ability to bypass points (zones) from System Galaxy
 ability to import Point Names from the alarm panel into System Galaxy
 ability to show device status on the alarm points (zones)

SYSTEM DIAGRAM: 
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Outline of the Configuration Process 

NOTES 

 Only authorized Galaxy Dealers can register System & Workstation features (master operator login is required). 
 Review the requirements section in this manual as well as the manufacturer’s equipment guides. 
 Configure the partitions and zones in the alarm panel before importing into System Galaxy 
 Physically connect the panel’s 4100 serial module to the System Galaxy server using direct RS-232 connection or 
using TCP/IP LAN to Lantronix connection (must run at 1200 baud) 

QUICK STEPS 
The steps below outline how to configure SG to interface with the Alarm Panel.  See Chapter 3 for full steps. 

STEPS 
1. Register System Galaxy for Alarm Panel Support (dealer/installer)
2. Configure the Alarm Options as needed (master operator)
3. Start the Alarm Panel Service and configure it to run “automatically”

Get to programming screens under Configure > Hardware > Alarm Panel…
4. Add the alarm panel to System Galaxy
5. Add any areas (partitions) to System Galaxy
6. Add the points (zones) by importing with the GET POINT TEXT button
7. Refresh the Hardware Tree to show all devices

SYSTEM GALAXY ALARM PANEL PROGRAMMING SCREENS: 
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System Galaxy 11

System Terminology 

TERMINOLOGY:  

Acknowledge (ACK) SG Operator must issue an acknowledge command to clear the SG Alarm Event.  When a point/input 
requires operator acknowledgment, it will generate an SG Alarm Event when it is armed and active. 

 To configure a point to trigger an SG Alarm Event:  the ACK checkbox must be 
checked in the input/point properties screen. 

 To generate an SG Alarm Event: the point must be armed and activated. Unarmed 
points will not generate an SG Alarm Event. 

 To acknowledge the SG Alarm Event: an operator must select the event and right-
click to choose the Acknowledge from the shortcut menu.  The operator can 
acknowledge a single alarm event or all alarm events (depending on system setup). 

 To clear or delete an SG Alarm Event: the operator must select the event and 
choose Delete from the shortcut menu.  Unacknowledged alarms cannot be deleted. 
Only acknowledged (yellow) or restored (green) alarms can be deleted. 

Alarm Handling Several system (workstation) options exist to control how alarms are handled in SG: 
 Pop up on Alarm (causes SG Alarm screen to pop in front of all other screens) 
 Prevent application shutdown w/ pending (unacknowledged) alarms 
 Allow Alarms to Automatically Delete when they’re acknowledged or restored 
 Allow Operator to ‘Acknowledge All’ alarm events in SG 

Alarm Panel “Alarm Panel” or “panel”, refers to the Vista alarm panel; a unit in the Burglar Alarm System. 

Alarm Panel Event An alarm panel event is detected and displayed in SG when an alarm zone/point becomes active, 
whether it is armed or disarmed.  Alarm panel events are logged in the Alarm Panel Event screen. 

‘Alarm Panel Event’ screen In SG, the ‘Alarm Panel Event screen’ displays the alarm panel events when they occur (real-time). 
The event is generated any time the zone is activated, whether the point/zone is armed or disarmed. 

Area (alarm partition) An alarm panel area in System Galaxy is the same as a partition at the Vista panel. 

Offline Events “Offline events” refers to alarm panel events that occur when the alarm panel is offline from System 
Galaxy. An offline condition occurs whenever communication is interrupted between SG and the 
Alarm Panel (i.e. alarm panel is in programming mode, network is down, SG alarm panel service or 
other core service is not running, SG software is shut down, panel is physically disconnected, etc.). 

Point (alarm zone) An alarm point in System Galaxy is the same as a zone at the Vista panel. 

SG (acronym) for System Galaxy – refers to the System Galaxy software or system. 

SG Alarm Event An SG Alarm Event happens when a armed point (zone) is ‘active’, provided the point has been 
configured in Galaxy to require operator acknowledgement (ACK is checked).  Points that are not set 
to ACK do not generate SG Alarm Events. See section on programming the alarm point. 

SG ‘Alarm Event’ screen In SG, the ‘Alarm Panel Event screen’ displays any alarm panel events that are armed and set to 
ACK at the point.  If the point is not set to ACK or is not armed it will not generate and SG alarm.   
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2 ~ System Galaxy Requirements 
This section provides a list of known requirements for integrating the Vista panels with System Galaxy.  

 See the manufacturer’s documentation for install and operation requirements for your alarm panel. 

System Galaxy Version and Product Level 

1. You must be running System Galaxy 9 (or later)

2. You must register System Galaxy for Alarm Panel Support (Corporate or Enterprise levels)

Vista Panel Programming 

3. You must setup the Vista panel (including the partitions & zones) before you can add them to the System
Galaxy software.  See Manufacturer’s documentation for details.

Communication & Connectivity 

4. Network/pc firewalls and must be open between the Galaxy server and the Alarm Panel(s).

5. The Alarm Panel must be physically connected to the System Galaxy Communication Server in order to
log/display events and issue operator commands.

a) The GCS Alarm Panel Service must be running on the communication server.

b) The GCS Client Gateway & GCS DBWriter services must be running on the communication server.

c) All GCS services must be able to maintain TCP/IP connections to each other (i.e. not blocked by
firewalls or other port blocking software).

6. Galaxy supports RS-232 Direct Connection to a single Alarm Panel can

7. Galaxy supports TCP/IP with a Lantronix device for multiple panels.

8. A 4100 SM serial module must be installed inside the panel.

9. You must use 1200 baud at the Vista panel and at the Lantronix. System Galaxy is hardcoded to use.
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3 ~ Program System Galaxy for the Alarm Panel Interface 

PREREQUISITES 

 You must have already configured your partitions and zones and zone text at the Vista panel 
 The alarm panel must be physically connected to the SG Server (via RS-232 direct connect or Lantronix). 

Register System Galaxy for Alarm Panel Support 

The Alarm Panel Support must be enabled/activated when the System Registration is performed. 

These settings must agree with the customer purchase agreement. 

NOTES 

 Only authorized Galaxy Dealers can register System & Workstation features (master operator login is required). 
 System-wide Features must match the customer purchase agreement.  
 A valid registration code and maintenance agreement is required. 
 The Alarm Panel Support feature is available in ‘Corporate’ or ‘Enterprise’ product levels.  

SYSTEM REGISTRATION: 

Alarm Panel Support will be enabled 
or activate when option is “checked” 
and System Registration completed. 

Corporate or Enterprise levels offer 
the Alarm Panel Support feature. 

 
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Configure ‘SG Alarm’ Settings in Workstation Options 

NOTES 

 A master operator login is required Workstation Options / System Settings features.  
 You must set the Point Properties to require operator acknowledgement (check the ACK option). 
 Points generate an SG Alarm Event when they are activated, armed and have their ACK option enabled. 
 Operator filters and privileges can affect operator’s ability to handle alarm events. See operator programming. 

System Galaxy provides options that control how incoming SG alarms get acknowledged and cleared. 

 Pop up on alarm – when checked, System Galaxy will pop the SG Alarm screen in front so that it immediately 
warns the operator to acknowledge the condition. 

 Prevent Application Shutdown w/ Pending Alarms – when checked, operator cannot close SG until the alarm 
events have been acknowledged. 

 Allow acknowledge all – when checked, the SG operator can acknowledge all alarms in the screen at once. 
 Allow delete command – when checked, the SG operators can choose to delete an SG alarm in the screen. 
 Automatically delete acknowledged and restored alarms – when checked, alarms are automatically deleted 

when they are restored or acknowledged by an SG operator. When unchecked, operators must delete the SG 
alarms as a separate step.  

 Automatically call up DVR video – when checked, System Galaxy will automatically start the DVR Viewer and 
show live feed from the associated camera where the alarm is occurring.  DVR programming is also required for 
this feature. 

SYSTEM SETTINGS (Alarm Options): 

 See the main System Galaxy software manual or system help for instructions on additional alarm options. 


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Add Alarm Panels in SG 

NOTES 

 Operator login must be set to allow full editing of Alarm Panel features. See Operator Programming screen. 

1. To add the alarm panel, open the Alarm Panel Properties screen:
From the SG MENU: Configure > Hardware > Alarm Panels > Alarm Panels

2. click the ADD button
3. type a descriptive name in the Name field
4. Select the Panel Type (Ademco Vista)
5. Choose the Connection Method

a. For Lantronix TCP/IP …
 Enter the IP Address
 Enter the port 3001

b. For Direct Connect
 Select the Com port to be used

NOTE: the baud rate is not configurable for Vista 
panel. It defaults to 1200 baud and must be set 
1200 at the panel and Lantronix device. 
NOTE: the Passcode field is unused for Vista. 

6. Choose the Communication Server
 Click THIS COMPUTER if you are currently

on the communication server.
NOTE: some networks have problems resolving
a PC name. if you are in doubt, set the PC’s IP
Address in this field.

7. Click APPLY button to save


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Add Alarm Panel Areas/Partitions in SG 

Alarm Panel Areas are the same as Partitions in the Vista interface. 

NOTES 

 Operator login must be set to allow full editing of Alarm Panel features. See Operator Programming screen. 

1. To add the partitions/areas, open the Alarm Panel Area Properties screen:
From the SG MENU: Configure > Hardware > Alarm Panels > Alarm Panel Areas

2. click the ADD NEW button
3. type a descriptive name in the Name field

TIP: if you want the area names to reflect which
partition number is represented, then include that
number in the name

4. check the SHOW IN TREE checkbox
NOTE: when checked, the partition/area will
display in the SG Hardware Tree

5. click APPLY to save


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Add Alarm Panel Points/Zones in SG 

Alarm Panel Points are the same as Zones in the Vista interface. 

NOTES 

 Operator login must be set to allow full editing of Alarm Panel features. See Operator Programming screen. 
 Graphic Symbols: (if using Graphic Floor plans) a point can be linked to images that represent each 
possible status condition – this is done on the Graphic Symbols tab. 
 DVR Camera Setting: a point can be linked to a camera and setup to automatically call video 
 CCTV / Web Camera Settings: a point can be linked to a CCTV switch to control CCTV feed or WebCam URL. 
 Audio Settings: a point can be linked to audio files to sound for Alarm and Trouble states 
 Options: a point can be set to generate event log messages to email, file, or line transmission (RS232 or TCP/IP) 

1. To add the points/zones, open the Alarm Panel Point Properties screen:
From the SG MENU: Configure > Hardware > Alarm Panels > Alarm Panel Points

2. click the ADD button
3. select the Area / Partition
4. click [GET POINT TEXT FROM PANEL]
5. type any operator response instructions
6. set ALARM PRIORITY as desired
7. check the ACKNOWLEDGE option to require an

operator acknowledgement and trigger SG Alarm
NOTE: Point must also be armed to trigger an alarm.

8. check the SHOW IN TREE checkbox
9. check ALWAYS ARMED if this is a 24 hour zone
10. check the BYPASS ALLOWED as needed

NOTE: panel must support bypass.
11. configure the symbols, cameras, cctv switching, audio

settings and output messaging as needed
12. click APPLY to save (or continue for advanced settings)

Continue on next page 


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GRAPHIC SYMBOLS TAB 
13. choose the input status condition you want
14. choose a symbol you want to represent that status

NOTE: Graphic symbols are only used if you are adding 
your points to a graphic floorplan.  The graphic floorplan 
displays on the SG Alarm screen.  The symbols change 
to represent the state you configured here. 

DVR CAMERA SETTINGS TAB 
15. choose the DVR unit
16. choose the camera you want to link to the point
NOTE: a camera in the area can be linked to the point and 
caused to pop-up when the point is active The ‘Automatically 
call DVR on Video’ must be checked if you want the DVR 
viewer to pop open to that live feed when the alarm 
condition occurs. 
IMPORTANT:  The point must be set to require operator 
acknowledgement. And the alarm must be armed. 
CCTV SETTINGS TAB 
17. choose the switch name
18. enter the alarm number
19. enter the camera number
20. enter the positon number
21. enter the monitor numbers as desired
22. choose a web camera URL if you are linking via internet

AUDIO SETTINGS TAB 
23. choose the alarm audio file as desired
24. choose the trouble audio file as desired

OPTIONS TAB (Log Distributer service must be running) 
25. check the Email Event Log if desired

(feature registration required) 
26. check the R232/IP Event Log if desired
27. check the File Output Event Log if desired

NOTE: Log Distributor configuration is required, 
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Set the Alarm Panel Service to Start Automatically 

System Galaxy connects to the Vista panel with the GCSAlmPnl service. The Alarm Panel Service should be 
set to automatically start when the PC is booted up. This is done in the Services management window. 

NOTES 

 Alarm Panel Service must be running for System Galaxy to receive events and send commands to the panel. 
 The core GCS services (ClientGW and DBwriter) must also be running to communicate with the panel. 
 GCS Services can always be managed through the PC Administrative Tools on any Windows OS. 
 Services can also be managed using the GCS Service Manager (XP) or GCS Service Monitor (Windows-7/Vista) 

1. open the Services management window:
From the PC START MENU:  Start > Control Panel > Administrative Tools > Services 

2. right-click the GCSAlmPnl service and choose
Properties from the shortcut menu

NOTE: you can start, stop, or refresh the service
from this shortcut menu.

3. select Automatic and click APPLY to save settings

 See the chapter on Administrative Features for more details on managing the GCS Alarm Panel Service. 


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4 ~ Operating System Galaxy Alarm Panel Interface 

Using the Hardware Tree 

The System Galaxy Hardware Tree can show panels, partitions (areas) and zones (points). You can also pull 
the event history reports of the panel, partitions and points from the hardware tree. 

NOTES 

 The SHOW IN TREE option must be ‘checked’ on the areas (partitions) and points (zones) before it will appear in 
the hardware tree. 
 The Hardware Tree may need to be refreshed to pick up newly added devices 

4. open or refresh the Hardware Tree:
From the SG MENU: View > Hardware Tree

5. You can arm and disarm the alarm system at the panel name or at the distinct area/partition from the
operator command menu (right-click on the panel or partition to select and issue the commands)

get the event history report  from 
the partition or point (zone) 

 

view panel, partition 
and point properties 

arm and disarm from the 
panel or the partition 
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Using SG to Monitor the Alarm Panel Events 

IMPORTANT 

 A disarmed input/point will create an Alarm Panel Event in SG when the input/point condition changes. 
 An armed input/point will create an SG Alarm Event only if the input/point is set to require acknowledgement. 
 System Galaxy will pop the SG Alarm screen in front of the normal event screen only if the ‘Pop on Alarm’ option is 
enabled (checked) in Workstation/System Options >Alarm Options tab.   
 Operator command menus are available by right-clicking an event or alarm message.  Availability of certain 
commands is affected by settings in the Workstation/System Options >Alarm Options tab. 

System Galaxy provides two screens that display the Alarm Panel Events. 

 The Alarm Panel Event screen shows all incoming events being reported from the panel.  
These events are generated from any point that changes condition at any time (i.e. during both 
armed and disarmed states). 

~ Red text indicates a trouble, fault or alarm condition has been reported by the panel.
~ Black text indicates a restored or secured condition has been reported by the panel.

 The SG Alarm Event screen shows only the alarms from armed inputs/points that are set to 
require acknowledgement (ref. Point Programming in previous chapter).  SG Alarm Events are 
generated when ‘armed’ inputs and points that have been configured to need operator 
acknowledgement when they occur. 

~ Red indicates an alarm/fault condition has been reported by the panel.
~ Yellow indicates an alarm/fault that has been acknowledged by the SG Operator.
~ Green indicates a restored condition has been reported by the panel.

EVENT MONITORING SCREENS: 
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Acknowledging Alarm Events 

The SG Operator can right-click on any alarm event to open the command menu and issue a command. 

NOTES 

 Some of the commands are enabled and disabled based on workstation options. 
 Operator filters also apply to the operator’s ability to control alarms.  

 See the main System Galaxy Software manual for more details on SG Operator privileges and filters. 

 See the Chapter 3 in this manual configuring Alarm Options in the System /Workstation Options screen. 

OPERATOR COMMAND MENU: 

COMMANDS DEFINITION 
AFFECTED BY 

OPERATOR FILTERS 
Acknowledge Operator command to acknowledge an alarm event Yes 
Who Acknowledged? Opens Message Box showing who acknowledged an alarm 

and the response that was entered if given. 
No 

Delete Operator command to delete an acknowledged alarm event Yes 

AFFECTED BY 
WORKSTATION OPTIONS 

Delete All Acknowledged Operator command to delete all acknowledged alarm events Yes – must be enabled 
Silence Operator command to silence an alarm audio file Yes – the audio will replay if 

the Repeat Alarm Audio 
option is enabled 

Acknowledge All Operator command to acknowledge all alarm events Yes – must be enabled 
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Posting Action Taken Response 

Once the SG Operator has issued the Acknowledge command, the response or action taken can be selected. The 
action taken will display in the Responses column 

NOTES 

 Alarm Responses are configured in System Galaxy. 
 A minimum response length can be required. 
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ADMINISTRATIVE FEATURES 

Using the Service Manager to Start Services (Windows XP) 

The GCS Service Manager is a utility that provides a way to interface exclusively with Galaxy services. 

NOTES 

 The Alarm Panel Service depends on the GCS ClientGW and GCS DBWriter services to also be running. 
 All necessary services should be configured to start automatically. 

 Windows-7/Vista OS Users: see the following section on using the GCS Service Monitor. 

The GCS Service Manager displays all the GCS services and shows their current status. 
From the PC START MENU:  Start > Program Files > System Galaxy > Utilities > Service Manager 

 Green indicates the serviced is running
 Red indicates the services is stopped

GCS SERVICE MANAGER: 

The services show on the task bar when they are set to interact with desktop. 

GCS INTERACTIVE ICONS ON TASKBAR: 
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Using the Service Monitor to Start Services (Windows-7/Vista OS) 

The GCS Service Monitor is a utility that provides a way to interface exclusively with Galaxy services. 

NOTES 

 The Alarm Panel Service depends on the GCS ClientGW and GCS DBWriter services to also be running. 
 All necessary services should be configured to start automatically. 
 GCS Services will not automatically interact with desktop on Windows-7/Vista OS 

The GCS Service Monitor displays all the GCS services and shows their current status. 
From the PC START MENU:  Start > Program Files > System Galaxy > Utilities > Service Monitor 

 Green indicates the serviced is running
 Red indicates the services is stopped

GCS SERVICE MONITOR: 
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Managing the Alarm Panel Service Connections 

The Alarm Panel Service allows the user to view and manage connections. 

NOTES 

 Ability to connect depends on proper configuration and the panel must be connected / online. 

 All dependant services must be connected 

The Alarm Panel connections tab shows the connection status for each panel . 

force a connect to the panel if the network connection has been interrupted. 
force a disconnect from the panel if desired 
send a ping to the Lantronix device from this screen as a troubleshooting tool 
set the connection properties 

ALARM PANEL SERVICE CONNECTION: 
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